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Abstract 

The abstract is a non-indented, brief paragraph that summarizes the key points of your study, 

experiment, or research.  It always has its own designated page that is titled Abstract and is about 

120 to 250 words in length.   It should never exceed one page.  The purpose of the paper is stated 

here (the thesis), along with any hypotheses or experimental information that is necessary to 

understand the paper from the beginning.  The findings/conclusions should also be stated here. 

Some college professors require an introduction instead of an abstract.  Be sure to check with the 

instructor regarding his or her preference for the title, content, and format of this section. 
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Complete Title of APA Paper 

 This sample paper demonstrates the formal elements required by the American 

Psychological Association (APA), according to its 6th edition, second printing of The Publication 

Manual of the American Psychological Association.  The 2010 APA style guidelines have been 

revised to reflect new technologies for informational sharing and publishing and for reporting 

those findings according to non-biased APA style rules. This format is applicable for social and 

behavioral sciences, including Psychology, Sociology, as well as nursing and business papers.  

Check with the professor to determine if this is the right style for the assignment.   

Formatting 

As demonstrated in this paper, the title page, an abstract page, body pages, and references 

pages are needed.  All pages of the paper will have a page number which is right justified and a 

header with the paper title in all caps (shortened if that title is more than 50 characters, including 

spaces and punctuation), which is left justified.  The exception to this is the title page. The title 

page will also have the words Running head: in front of the capitalized title.  The cover page 

includes the complete title of the paper. This, followed by your full name and the name of your 

educational institution on subsequent double-spaced lines, is placed in the upper half of the page.  

The title should summarize the main point of the paper. The essay will start on page three since 

the first two pages are always reserved for the title page and the abstract.  When beginning the 

paper, indent each new paragraph using the TAB key (an automatic indent of seven spaces).  

Notice the text is double-spaced, the page has one-inch margins all around, and no extra blank 

lines are included between paragraphs.  APA recommends using a 12-point Times New Roman 

font with two spaces after each period.  
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Headers and Page Numbers 

In Word, to create a title page with the words “Running head,” look for the “Insert” tab, 

choose “Page Number,” then “Top of Page,” followed by “Plain Number 3.”  Then, also in the 

“Insert” tab, choose “Header,” then “Edit Header.”  Notice the “Different First Page” option that 

appears. Select this and type the words “Running head” followed by a colon and shortened title 

in all capital letters. Hit TAB until the title moves to the left side of the page. After creating the 

cover page and text is ready to be added to the second page, follow the same steps for adding a 

Header. Under the “Insert” tab, choose “Page Number,” then “Top of Page” followed by “Plain 

Number 3.” Make sure the Different First Page option remains checked. The pages numbers will 

already be in place, simply add the shortened title in all capital letters. This information will 

appear on all subsequent pages of the document. 

Levels 

This sample paper is divided into sections, or what APA refers to as “levels” or 

“headings” (not to be confused with “headers”). APA's levels allow the discussion to be broken 

down into manageable parts. Unlike in MLA or Chicago, you are not required to maintain 

coherency throughout your paper, nor are transitional sentences between ideas as important.  

Levels are divided according to topic, and then further levels, up to five, are assigned according 

to the amount of detail for that section.  These different levels are also designated by different 

format headings.  This paper has three levels, as shown below: 

I. Introduction 

II. Formatting 

A. Headers and Page Numbers 

B. Levels (this section) 

III. Citations and Documentation 

A. In-text Citations 

B. Direct Quotations 

C. Block Quotes 
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VI. Language 

A. Expression 

B. Nondiscriminatory Language 

VII. References 

VIII. Conclusion 

 

In this paper, notice the first level headings are centered and bolded (with the exception of the 

title page, the Abstract, and the References page), and the second level headings are left aligned 

and also bolded.  Both the first and second level headings are in title capitalization.  For 

guidelines on additional levels in APA, refer to the OWL Purdue Online Writing Lab “APA 

Headings and Seriations” section. 

Citations and Documentation 

 In-text citations in APA work very differently from those in MLA or Chicago.  APA uses 

parenthetical citations using an author-date format.  Examples for this follow, but directions are 

also in the "APA Style" section of The Little Seagull Handbook with Exercises, 3rd edition 

(Bullock, 2017) and in the “APA Style” section of the OWL Purdue Online Writing Lab (2018).  

Getting the format correct is a matter of reading the directions for the type of source being cited, 

and following the detailed instructions and examples. 

In-text Citations 

  When introducing source information and giving credit for ideas or findings, APA uses 

an author-date format, otherwise known as “parenthetical referencing.”  This type of in-text 

citation can be accomplished either by using a signal phrase including the author’s name, with 

the publication date in parentheses, or by providing that same information at the end of the 

sentence in parentheses. Parenthetical references should be used when quotations, paraphrases or 

summaries have been included in the paper.  It is necessary to document the source of the 

material whether using direct quotations or paraphrasing. Otherwise there is a risk of plagiarism.  
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Here is an example of a parenthetical reference: Clark (2008) suggests the number of students 

who admit to cheating, which had reached about 50 percent in 2002, has actually decreased (p. 

74). 

Direct Quotations 

 When using direct quotations to convey the author’s exact words, it is necessary to 

provide the author’s name, the source’s year of publication, and the page number of the quote.  A 

direct quote can be introduced in several ways. First, the author is mentioned in an opening 

phrase, followed by the year in parentheses, and ending with the page number after the quotation.  

An example of this follows: Seedat and Lazarus (2011) state that they “draw on various sources, 

including undocumented small histories of organized groups and individuals” (p. 241).  In 

another approach the author is not mentioned in a signal phrase. Instead, the author(s), year and 

page number are given after the direct quote.  An example of this format follows: The 

researchers involved "draw on various sources, including undocumented small histories of 

organized groups and individuals" (Seedat and Lazarus, 2011, p. 241).  Notice the page number 

is preceded by “p.”, the end punctuation follows the parenthesis, and there are commas in 

between the author name, the date, and the page number. 

Block Quotes 

 Some direct quotations are too large to insert into body paragraphs and must be off-set 

with special formatting. APA requires that all quotations over 40 words be blocked.  As with 

shorter quotes, a block quote may be introduced with a signal phrase or not, but either way 

follow the same format as detailed in the direct quotations section above to include all the 

relevant information (author’s name, publication year, page number) placed where applicable.  

The entire block quote should maintain double spacing and be indented one half inch from the 
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left margin, one TAB (this can be accomplished by highlighting the entire quote and then tapping 

the TAB key once). When signaling the blocked quotation, be sure to use a colon to indicate 

such: 

For quotations that extend to more than four lines of verse or prose, place quotations in a 

free-standing block of text and omit quotation marks. Only indent the first line of the 

quotation by an additional quarter inch if citing multiple paragraphs. The parenthetical 

citation should come after the closing punctuation mark. When quoting verse, maintain 

original line breaks. (Paiz, et al., 2012) 

Resume normal margins once returning to the paragraph, but do not indent the first line when 

you return to the paragraph, as it will make it seem like a new paragraph.  Additional text should 

follow the blocked quotation in order to avoid having a quotation floating within the body 

paragraphs.  Including words after a block quote will ensure understanding of the quotation, 

rather than just filling space.  Remember, all in-text citations, paraphrasing, or direct quotations 

need to have a corresponding source on the References page. 

Language 

 APA is unique from the other writing styles not only because of its formatting but also 

because of its language requirements.  Although all academic papers contain specific standards 

as to what sort of language to use, the APA section of the OWL Purdue Online Writing Lab on 

“APA Stylistics: Basics” features detailed guidelines for grammar and word usage that should be 

consulted before beginning a paper.  The most important of these rules is to maintain an 

objective, neutral tone throughout the paper, and to avoid flowery diction or overtly complex 

sentences.  The purpose of writing in APA is to clearly and succinctly report one's findings or 

research in as simple a manner as possible.  
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Expression 

 In APA, as with most of the other writing styles, the writer should be very careful as to 

use of voice.  Generally, active voice is preferred and is especially needed when describing 

experimental results.  “When the subject is acting, the verb is in the active voice; when the 

subject is being acted upon, the verb is in the passive voice,” (Lunsford, 2010, p. 289). In 

general, APA style papers use past tense (it showed) or present perfect tense (it has shown).  An 

exception to this is in the discussion of results or generally accepted information when the 

present tense (it shows) is used.  Additionally, APA style emphasizes the importance of clarity 

and conciseness. Provide adequate but briefly descriptive details for understanding. 

Nondiscriminatory Language 

 APA is also specific about nondiscriminatory language, particularly in regards to race, 

age, gender, sexual orientation, and disabilities.  Because APA style demands objectivity, any 

political or personal bias is to be avoided unless, of course, doing so would obstruct clarity or 

meaning in the writing.  APA's general rule is to use the labels that the participants prefer. For 

instance, when doing a study with controls for race, consult the participants as to their 

descriptive preference.  As for gender references, if the subjects are of both genders, then use a 

descriptive noun (child, person, individual), nouns (children, people, individuals), an article 

(the), or rephrase the sentence to remove any mention of or reference to gender (he/she).  For 

more details on nondiscriminatory language, consult the OWL Purdue Online Writing Lab 

section named “APA Stylistics: Avoiding Bias.” 

References 

 The References page, at the end of the paper, always begins on a new page.  Start by 

centering the word “References” on the first line, and continue double spacing on this page as 
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well.  This page will include all of the information about the sources cited in the paper.  Each 

reference entry will differ depending on the kinds of sources used for the paper, such as book, 

periodical, edited collection, or electronic source. Consult the “APA Style” section of the 3rd 

edition of The Little Seagull Handbook with Exercises or the OWL Purdue Online Writing Lab 

“APA Style” section before writing the citation.   

The first line of the citation should begin at the left margin, and all subsequent lines 

should be indented.   In many word processing programs, this is called a “hanging indent;” it can 

be found in the paragraph format menu of Word.  Click on the small arrow in the bottom right 

corner under the “Paragraph” section under the “Home” tab. In the pop-up window that appears, 

in the “Special” drop down menu, click on “Hanging.” Click “OK” to save the changes.   

Also, be sure the entries are arranged in alphabetical order according to the first letter of 

the first part of each entry.  Do not use quotation marks for shorter works such as article titles; 

further, capitalization is only used for the first letter of the first word. Publication, or source, 

information is placed in italics.  

Some citations in the reference page for online sources might require a DOI or URL. 

When DOIs are available, they are preferred over URLs. If there is not DOI available, provide 

the URL. If a DOI or URL won’t fit on one line, break it after a double slash or before any 

punctuation by adding a space; this will move the rest of the DOI or URL to the next line. Do not 

add a period at the end of the DOI or URL, and do not break the  

“http://” portion of the URL. Remove any hyperlinks added to DOIs or URLs by right-clicking 

on them and selecting “Remove hyperlink.” 
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Conclusion 

This sample paper was created to show, rather than just tell, about APA documentation 

and formatting.  In addition to the sources referenced throughout the paper, the American 

Psychological Association website, www.apa.org, should also be consulted.  The campus 

Learning Commons is also a valuable resource (Learning Commons, 2018). Further questions 

about APA or specific assignment requirements should be directed to the instructor who is the 

first and last reference concerning the assignment. 
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(This style guide was adapted for Pikes Peak Community College, Summer 2012, SDK and RHP. 

It was updated in Fall 2018) 


